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TO OUR CUSTOMER:

Congratulations on your selection of an AGCO® Product. We believe

you  have  exercised  excellent  judgment  in  the  purchase of your

product.  We are most appreciative of your patronage.

Your dealer will discuss with you the instructions given in this

manual, and instruct you in the proper applications of this product. Call

on him at any time when you have a question.

AGCO®  equipment  is  covered  by a  written  warranty  which  will

be provided to you by your AGCO® Dealer at time of purchase.

AGCO® reserves the right to make changes or add improvements to its products at any time without incurring
any obligation to make such changes to products manufactured previously. AGCO®, or its dealers, accept no
responsibility for variations which may be evident in the actual specifications of its products and the
statements and descriptions contained in this publication.

The rights, title and interest in all copyrights in any software text or graphics herein are owned or licensed by
AGCO. No publication, copying or distribution of the material herein is permitted without the consent in
writing of AGCO. AGCO does not warrant that your use of information herein will not infringe the rights of third
parties who are not related to AGCO.
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General Information

GENERAL INFORMATION

INTRODUCTION

The GTA100 Communicator software application allows a
user to transfer data logged on a memory card from a
GTA Console, or a Fieldstar Terminal, to a computer. The
data is organized and presented as Jobs that can be
previewed or exported into one or more formats for use in
other third party applications.

FIG. 1: The screen view above shows the GTA100 main
program window.

A Job consists of user-defined information and actual
machine logged data. User defined information
includes:

• Operator Name

• Job Name

• Farm Name

• Field Name

• Operation Type

• Implement Width (for pull type implements)

Some information can also be entered directly into the
GTA Console, or Fieldstar Terminal, by the user. All
user-defined information can be edited using GTA100
software.

GTA Console in a tractor will automatically log date,
time, console ID, and machine hours; as long as a
Secure Digital (SD) memory card is inserted into the
console. 

FIG. 1

gtac0359
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DATA LOGGING HARDWARE

Data can be read or written, for use in GTA Software
products, using a FIELDSTAR Terminal (1), GTA
Console I (3) or GTA Console II (4).

Fieldstar® Terminal

FIG. 2: Fieldstar Terminal (1) uses a PCMCIA Linear
Flash Card (2).

GTA Consoles

FIG. 3:  GTA Consoles (3 and 4) use SD Memory Cards
(5).

FIG. 2
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PC SOFTWARE

FIG. 4: GTA100 Communicator has an easy to use
software interface that processes and exports
machine-generated data. The data can be processed by
the user, or can be exported for use by an agronomic
consultant.

The main screen consists of two components:

• Resource Manager (1)

• Farm tab

• Inputs tab

• Data Viewer (2)

• Jobs tab

FIG. 4

gtac0163
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APPLICATION

RESOURCE MANAGER

Farm Tab

FIG. 5: The Farm tab (1) stores multiple farms and
fields. Its "tree" structure enables the user to easily view
the fields that belong to certain farms.

Inputs Tab

FIG. 6: The Inputs tab (2) can be used to create and
record key information for Machines, People, and
Supplies.

Resource information may include:

• Make and Model

• Date of Last Service

• Hours to Next Service

• Charge per Hour or Acre

• Serial Number

• Photo of Machine

• Operator's Information

• Cost per Hour

• Contact Details

• Personnel Photos

• Supplies

• Cost per Unit

• Cost per Acre

• Default Application Rate per Acre

• Product Restrictions

• Regulatory Information

FIG. 5

gtac0164
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FIG. 6

gtac0165
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Application

DATA VIEWER

FIG. 7: The Jobs tab shows all jobs stored within
GTA100 Communicator. Jobs can be sorted in either
ascending or descending order, by clicking on the column
headers (1).

The Properties button (2) displays the information for the
selected job in the job properties window (3). This
information can be changed if needed.

The Job Summary and Details tabs (4) provide a short
overview of the information stored within a job. The
Details tab displays the minimum, maximum, and average
values for any information logged by the terminal/console
in relation to the selected job.

The Export button (5) is used to export job data from
GTA100 Communicator. Job data can be exported in the
following formats:

• Comma Separated Value (*.csv)

• Shape Files (*.shp)

• FODM XML Files (*.XML)

The Edit Filter button (6) is used to filter jobs shown on
the Jobs tab.

FIG. 7

gtac0167
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FIG. 8: The Job Filter window filters job data by any of
the following criteria:

• Date

• Farm and Field

• Year

• Commodity

• Job Type

• Operator

• Console ID

• Input (Machine, Person, and Supply)

• Job Status (Completed or Planned)

FIG. 9: Jobs can also be filtered by Farm, Field, or Input
by checking either the Filter Jobs by Farm or Filter
Jobs by Input boxes (7).

FIG. 8

gtac0168

FIG. 9

gtac0169
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FILE MENU OPTIONS

Backup Project

FIG. 10: The data files for the program will be copied to
the location that you specify. It is recommended to store
backup files on removable media such as a CD or
Memory Card.

IMPORTANT: It is a good practice to backup data on a
regular basis.

Restore Backup

The data files for the program can be restored in the case
of a system failure or other unforeseen problem. The
restore function can also be used to move data to a new
computer.

Read Job Data

FIG. 11: Job data may be imported into GTA Suite from
several controller types or locations:

• FIELDSTAR (data card, individual file, or Open Office
Database)

• Datatronic III, Power Performance III (SD Card or .acf
file)

• Task Controller (SD Card or .xml)

• Third Party Data (individual files)

• Generic Import (Soil Sample, Text Files, or FODM
.xml)

FIG. 10

gtac0170

Read Job Data button

FIG. 11

gtac0490
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Write Job Data

FIG. 12: Job data can be written to these media devices:

• SD Card Device

• Linear PCMCIA Card Drive

Synchronize Trac Mate

Job data can be transferred to a Personal Digital Assistant
(PDA) running Farmworks Trac Mate software. The jobs
can be modified in Trac Mate and then imported back into
GTA100.

Write Job Data button

FIG. 12

gtac0491

Synchronize Trac Mate button
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VIEW MENU OPTIONS

FIG. 13: View menu

Show Retired Land Areas

Retired Land Areas will be shown by selecting this option.

Show Retired Inputs

Retired Inputs will be shown by selecting this option.

Enterprise Properties

FIG. 14: Enterprise Properties will be shown by selecting
this option.

An Enterprise is a combination of a year and commodity
that is used to help sort jobs by field.

NOTE: The Enterprise Property is created automatically
upon reading data into the system.

Use the Enterprise Filter, as shown in this screen, to
view jobs associated within a given year and commodity.
Individual job selections can be Edited and Deleted as
needed.

FIG. 13

gtac0171

FIG. 14

gtac0172
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RESOURCES MENU OPTIONS

FIG. 15: The Resources menu has options for the entry
of:

• New Farm

• New Field

• New Person

• New Machine

• New Supply

• Other (Commodities, Markers)

Click on any one of the above options to enter information
specific to the option.

NEW FARM

FIG. 16: Clicking on the New Farm button, or selecting
the New Farm option, will open the Farm Properties
window. The name of the farm can be entered in the
Description box (1). The Area of the farm (2) cannot be
entered because this information is calculated based on
the area of the fields that are listed under the farm. The
Notes portion (3) of this properties window can be used
to record comments unique to the individual farm.

FIG. 15

gtac0173

New Farm button

FIG. 16

gtac0174
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NEW FIELD

FIG. 17: Clicking on the New Field button, or selecting
the New Field option, will open the Field Properties
window. The Field Properties window has three tabs;
general, legal and photo.

Enter a field name in the Description area (1). Enter the
field's tillable number of acres in the Tillable box (2).

The last section (3) is used to define which farm the field
belongs to and whether it is owned, cash rented, or share
cropped.

NOTE: Field Description and Tillable acres are
REQUIRED.

FIG. 18: Detailed legal information, defining the field, can
be entered on the Legal tab (4).

The legal land description can be entered in the Legal
section (5) of this screen.

FIG. 19: The Photo tab (6) allows the user to import an
Aerial image of the field.

GTA Suite supports the common file types listed below:

• Windows bitmaps, .bmp

• Tag Image File, .tif

• Paint, .pcx

• JPEG, .jpg

NOTE: The user is responsible for obtaining all photos.

FIG. 17

gtac0175
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New Field button

FIG. 18
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NEW PERSON

FIG. 20: Clicking on the New Person button, or
selecting the New Person option, will open the New
Person Properties window. This window allows for the
entry of farm personnel.

There are four entry tabs for information:

• General

• Address

• Contact

• Photo

FIG. 21: The Address tab (1) is shown to the right. It is
not required to enter this information to establish a person
in the database.

FIG. 22: The Contact tab (2) is available to enter
additional information, pertaining to the person. Entry of
this information is not required.

FIG. 23: The Photo tab (3) allows the user to import an
image of the new person. 

NOTE: The user is responsible for obtaining all photos.

FIG. 20

gtac0178

New Person button

FIG. 21

gtac0179
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FIG. 22

gtac0180
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FIG. 23

gtac0181
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NEW MACHINE

FIG. 24: Clicking on the New Machine button, or
selecting New Machine option, will open the New
Machine Properties window. This allows detailed
information, for machines used, to be entered.

Four input tabs are shown in the Machine Properties
window:

• General

• Service

• Options

• Photo

The General tab requires that a Machine Description and
Category be entered.

The Category drop-down menu (1) indicates the type of
job the implement is used for.

Entering data in the Operation section (2) of this window
is needed to create accurate Cost per Hour and Cost per
Acre reports.

FIG. 25: The Service tab (3) is very useful for reporting
service intervals for machinery.

NOTE: When using GTA Consoles, it is unnecessary to
enter Current Meter information because the
console will record that information and upon
importing, it will update automatically.

Service related comments can be entered in the Service
Notes box (4) at any time during the life of the Implement.

New Machine button

FIG. 24

gtac0182
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FIG. 26: The Options tab (5) allows the user to enter
the fuel attributes of the machine.

The entry of these options greatly increases the value of
data collected for Fuel Consumption reports. It is
recommended to define all fuel types, such as diesel or
gasoline, under supplies on the Inputs tab, before
entering machine properties.

FIG. 27: The Photo tab (6) can be used to import a
digital image of any implement used in the production
enterprise.

Pictures saved to the computer, can be imported under
Machine Properties, using the Change Photo button
(7).

NOTE: The user is responsible for obtaining all photos.

FIG. 26

gtac0184
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FIG. 27
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NEW SUPPLY

FIG. 28: Clicking on the New Supply button, or
selecting New Supply option, will open the New Supply
Properties window. In the Supplies Properties window,
supplies used in the farming operation can be entered.

Four input tabs are shown in the Supply Properties
window:

• General

• Chemical

• Fertilizer

• Restrictions

The Description, Type, and Units sections are required
entries on the General tab (1).

After completing the General tab, the Chemical,
Fertilizer and Restriction tabs can be completed.

FIG. 29: The Chemical tab (2) of the Supply
Properties window allows the user to enter complete
and accurate product information so as to maintain good
records of the pesticides applied.

The Target Problems entry area (3) allows the producer
to identify up to five pests per product.

Pest lists can be created by clicking on the Add/Edit
Problem List button (4).

New Supply button

FIG. 28

gtac0186
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FIG. 29

gtac0188
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FIG. 30: The Fertilizer (5) tab of the Supply
Properties window is used to enter the fertilizer's
analysis. Clicking on the white box under the Nutrient
category will bring up a drop box to allow the user to
select their desired nutrient. Clicking on the white box (6)
under the Percent category will allow the user to input the
appropriate percentage.

FIG. 31: The Restrictions (7) tab of the Supply
Properties window is used to enter the appropriate
information as prescribed by the pesticide's label.

NOTE: The Re-entry Restrictions box (8) needs to be
checked in order to input information.

The final box on this screen will signify the need for
Posting Treated Areas and Oral Notification
Required (9). Some states require the posting of various
pesticide applications on the perimeter of the crop
production area.

FIG. 30

gtac0187
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FIG. 31

gtac0189
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OTHER

FIG. 32: The Commodities window is used to identify
the common crops in a production enterprise. A crop list
can be viewed by clicking on Add (1). Once a crop is
selected the user can click OK, causing a window to open
allowing the user to input or change the Commodity
Properties. 

FIG. 34: The Commodity Properties window (2)
contains details for a specific crop. The Properties
section of this window is used to identify the unique
characteristics of each crop.

NOTE: Defining the information unique to the
Commodity allows for accurate crop calculations
in GTA Suite.

FIG. 32

gtac0190

1

FIG. 33

gtac0191

FIG. 34
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MARKERS

FIG. 35: The Markers window enables the user to
create a list of meaningful Markers to be used when
collecting and logging data in the field.

The Markers created and listed in the window are spatial
identification labels. The Fieldstar Terminal can use this
group of labels to log spatial data representing
single-point or multiple-point data.

Markers can be deleted or renamed using the buttons in
this window.

TOOLS

FIG. 36: The Tools menu has been created to allow
machine specific software applications to be included in
the software.

For tractors equipped with a Datatronic 3 Console:

• SD Card Tool

• Allows downloading, editing and saves tractor
settings to a computer.

• Setting can be written back to a card, allowing
the use of the same setting each year.

NOTE: For a more detailed description of the SD Card
Tool, see Appendix I at the end of this Training
Manual.

• Installing SD Card Tool 

• Using the GTA Suite Installation CD, browse
contents and open the Tools folder.

• Select the SD Card Tool folder and run setup.exe,
to install the software.

• After installing the SD Card Tool, it will be
available under the Tools menu.

HELP

FIG. 37: The Help menu option is primarily for
verification of software versions as well as checking for
product updates.

FIG. 35

gtac0193

FIG. 36

gtac0126

FIG. 37

gtac0125



Application

20 79023539 C Rev.  

NOTES



79023539 C Rev.  21

Appendix

APPENDIX

SD Card Tool - Users Manual 

For use with: 

Massey Ferguson - Datatronic 3 

AGCO - Datatronic 3 

Challenger - Power Performance 3

Revision 1.3 
Date 1/5/05 
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1.  SD Card Tool Introduction

The SD Card Tool is a PC based software program. The program can read and write 
memory values and tractor settings stored to an SD card in the tractors GTA Console. 
Please see the accessories and options section in the tractors user manual for instructions 
on how to do this. 

To access the program open the GTA Suite and click on the “Tools” menu, a drop down list 
will appear to show the SD Card Tool menu. 

The SD Card Tool program is made up of six sections 

• Memory – Accumulated Values  

• Valves - Electro-Hydraulic 

• Headland - Management 

• Tractor Settings

• Dual Control

• About SD Card Tool

The six sections are designed into three areas: 

1. The main area displays or sets data in the PC database of the SD Card Tool 
program.

2. The second area allows the user to navigate the PC database, to delete memories, 
and to transfer memories to the SD Card. 

3. The third area displays the memories names on the SD Card, and has controls to 
delete and transfer memories to the SD Card Tool PC database. 

1

2

3
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2.  Area 1 Functions - Memories & Settings

2.1  Memory – Accumulated Values Page 

This page displays all the accumulated values of a selected Datatronic 3 or Power 
Performance 3 memory e.g. working area, fuel consumption, working hours, and distance 
travelled. These values are transferred from the SD Card and held in the SD Card Tool PC 
database, see section 4.2. 

1 - This icon displays the trigger that activated the count function in the memory e.g. 
hitch down, PTO on, etc; this also determines when the tractor was in or out of work 
to calculate the worked area. 

1
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2.2  Electro-Hydraulic Spool Valve Settings Page 

This page displays the stored electro hydraulic spool valve settings stored within the 
displayed memory. The user can adjust these settings and then transfer them to the SD Card 
for use in the tractor. It is possible to adjust the settings as detailed below for up to 6 valves. 

1 - Green valve positive oil flow in percentage (0 to 100%). 
2 - Green valve negative oil flow in percentage (0 to 100%). 
3 - Click on this button for activate or deactivated the valve into floating position. 
4 - Operation time until the valve kicks-out (0 to 60 s). 
5 - Click on this box to have a permanent oil flow from the valve. 

1

2 3

4

5
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2.3  Headland Settings Page 

This page enables the generation of a headland sequence or displays a sequence stored in 
a memory. Depending on the tractor specification it is possible to choose between 46 
different headland actions from the matrix to generate a headland sequence with up to 35 
actions in total. This sequence can then be transferred to the SD Card for use in the tractor. 

1 - Headland Action 
2 - Headland sequence  
3 - Button to delete the last action in the sequence 
4 - Drop down list to set the time between each action 
5 - Drop down list to choose the tractor transmission type 

To insert an action in the headland sequence (2), click on an action icon (1). To replace an 

action in the sequence, click on the action icon to be removed, an ? icon will appear, then 

click on another action to replace the ?.

1

2

3

4

5
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2.4  Tractor Settings Page

This page enables parameters to be set for working width, memory count activation, 
transmission, engine speeds and oil flow priority between the hitch and spool valves. The 
transmission settings only work on a tractor with a Dyna-VT (CVT) type transmission. The 
transmission type is selected in the drop down list in the headland settings page. All the 
values are transferred into the DCC when the memory is activated in Datatronic 3 or Power 
Performance 3. 

In this area, set: 

- The working width 

- The memory count activation trigger (click on the 
button to change the event selection) 

In this area, pre-set memory A & memory B engine speeds in 
rotation per minutes. 

This area enables the oil flow priority to be set between the hitch and the 
hydraulic spool valves. (In this example, 10% hydraulic oil flow to the 
spool valves / 90% to the hitch flow) 
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This area enables the transmission parameters for Low range and High range to be set on a 
Dyna-VT (CVT) type tractor. 

1 - Set the cruise control speed SV1 
2 - Set the cruise control speed SV2 
3 - Set the start speed in forward and reverse directions 
4 - Set the Max. speed in pedal mode 
5 - Set the pedal mode response between 0 and 3 

2.5  Dual Control Settings Page 

This page displays the dual control settings and calibrations connected to the selected 
memory and transfer them to the SD Card for use in the tractor. It is not possible to change 
any settings in this page,  

1

2

3

4

5



79023539 C Rev.  29

Appendix

2.6  About SD Card Tool Page 

This page allows application settings to be made for the SD Card Tool Program. It also 
displays the program version number e.g. 1.3  

1 - This button enables navigation to and selection of the SD Card Tool PC database 
file, this is done through a normal Windows “Open file” command. To create a new 
database file, write a new name in box 5 followed by the extension “.d3db” and a 
new database file (.d3db) will be created. 

2 - This button enables selection of the SD Card path; this is done through a normal 
Windows “Open file” command. 

3 - Select the language, English, French or German. 
4 - Select measurement system, Metric, UK or US. 

1

2

3
4

5
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3.  Area 2 Functions – Memory / Settings Navigation

3.1  PC Database Memory Navigation  

1 - Displays the current memory name  
2 - Buttons to navigate through the PC data base 
3 - Button to delete the current displayed memory 
4 - Number of displayed memory and the total number of memories stored in the 

database
5 - This button transfers the current displayed memory to the SD Card 

3.2 Creating A New Memory 
• To create a new memory, first write a new name in the memory name box (1). A 

new memory is created with all values set to 0 and adjustments can then be made 
to the settings. 

1

2
3

4
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4.  Area 3 Functions - SD Card

4.1  SD Card Management 

1 - Window displaying the names of the memories stored on the SD Card. 
2 - Check this box, to automatically erase the selected memory when it is transferred in 

PC database. 
3 - This button erases the selected memory on the SD Card. 
4 - This button erases all memories on the SD Card. 
5 - This button transfers the selected memory in to the PC Data base. 
6 - This button transfers all memories in to the PC Data base. 
7 - This icon displays via a percentage figure and bar graph the amount of space used 

in the “accum.dat” file on the SD Card. 
8 - This icon displays via a percentage figure and bar graph the amount of space used 

in the “para.bin” file on the SD Card. 
9 - This button refreshes the list of memories displayed in the memory window 1. Use 

this if the SD Card has been connected or inserted after the SD Card Tool 
application has been opened. 

10 - Exit button, to close the program. 

4.2 Reading SD Card Memories 
• To read a SD Card memory, select it in the memory list by left clicking on it in list 

box (1) and then use button (5) to transfer it in to the PC database. 

1

2

3 4

5

6

7

8

9 10
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4.3 File Types 
• Para.bin – this file holds the information for Electro Hydraulic Valves, Headland 

Management, Tractor Settings and Dual Control. 

• Accum.dat – this file holds the accumulated values stored in Datatronic 3 / Power 
Performance 3 memories. 

Please note that the file relating to the accumulated values is different to the one relating to 
the other parameters. For this reason, it is possible that the list of memories attached to the 
“Memory” page might not be the same as the list attached to the other pages. 



AGCO® has Parts Distribution Centers strategically located to

provide your AGCO® Dealer with quality replacement parts in a timely

manner.

In  addition  to  quality  repair  parts,  the  company  offers  numerous

accessories and a full line of quality filters and lubricants.

Protect  your  investment  with  parts  and  service  from  your

AGCO® Dealer.
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